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How to Use the Brand Standards
This brand guideline reflects the strategic intent of our brand. It defines 
standards for our logo, typography, color palette, imagery, and graphic 
elements. These standards help ensure the consistent visual expression of 
our brand to build brand recognition. By correctly applying our visual identity 
elements, we can create a distinctive brand that redefines the industry in 
which we operate. Our visual identity works in conjunction with our verbal 
identity to emphasize our brand’s personality. It also creates a consistent look 
and feel that provides a cohesive brand experience across all touchpoints.

The CPSC brand personality can be summed up as “the trusted source” of 
consumer safety information. The brand should always demonstrate wisdom, 
empathy, and insight. All content and representations of the CPSC should 
convey a sense of confidence that information is backed by knowledge and 
research and based in analytical thoughtfulness. The CPSC brand personality 
is committed to educating consumers in a very clear and understandable 
manner. It should always be caring and concerned without being authoritative 
or overbearing. Ultimately, the brand is set on a position of providing useful, 
usable, and factual information to the world from careful research and 
analysis of issues that could affect the safety of consumers. 

Brand Standards



INTRODUCTION
Section One
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Introduction 

Section 1.1

Defining a Brand
Consistency and clarity are the hallmarks of every strong brand. Consumer 
and employee confidence in our brand starts with consistency in all visual 
elements and clarity in all messaging components. To have consistency 
and clarity, we must start with a well-organized and clearly defined brand 
style guide. This foundational base of our brand is the guiding document 
for all branding, marketing, and campaign design decisions.

Section 1.2

The Consumer Product  
Safety Commission
In support of the CPSC’s mission, it is essential that all branded materials 
follow a set of visual standards to ensure that we present our brand with  
the level of professionalism and credibility that is essential to maintaining  
a positive influence on manufacturers, consumers, and employees. 

This document provides you with visual elements of the brand and 
instructions on how to use those elements. Adhering to the standards 
when working with the visual elements ensures consistency in the look 
and feel and our overall expression of the brand.



LOGOS
Section Two
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Logos

Primary Logos
This is the logo of the United States Consumer 
Product Safety Commission logo. The CPSC 
logo should appear on all consumer-facing 
materials and should not be altered in any way.

Minimum Size
The CPSC logo must be sized large  
enough to be easily read in every application. 

Although minimum sizes are specified,  
the logo should generally appear larger than  
the minimum size.

Clear Space
Clear space is the area surrounding a logo that 
is kept free of other graphics and typography. 
It plays an essential role in ensuring our 
logo is easy to recognize across all of our 
communications. Clear space is essential to 
give our logo prominence. 

To avoid visual clutter, maintain adequate 
clear space between the logo and other visual 
elements. The space surrounding the logo 
should be maximized at all times. As illustrated 
on the right of this page, the minimum clear 
space surrounding the logo is specified by:

Colors

Section 2.1

Logo Usage

Print Size

Digital Size

100 px

1 in

Minimum Size

Clear Space

Tip: Logo type and mark should  
always be scaled up or down equally.

C: 13 M: 100 Y: 94 K: 3
PMS: 281 C

CPSC Blue
C: 100 M: 93 Y: 28 K: 23
PMS: 186 C

CPSC Red

1in
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Logos

Primary Logos
This is an alternative CPSC logo lockup.  
This option can also appear on consumer-
facing materials and should not be altered 
in any way.

The logo mark may be used without 
corresponding wraparound text if the brand 
name is featured nearby or thereafter.

United States
Consumer Product Safety Commission
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Overview
It is important to use the CPSC logo artwork as 
provided to preserve the integrity of the brand. 
The examples on this page illustrate some, but 
not all, potential misuses of the logo. 

Keep in mind that the logo is carefully rendered 
artwork and any alteration of the logo, apart 
from proportional scaling, is considered misuse. 

Section 2.2

Incorrect Use of Logo

Do not add a gradient.

Do not change the logo’s color.

Do not add a drop shadow.

Do not place on a busy background.

Logo should never be pixelated.

Do not stretch in any way.

Logos

 C
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Do not add any additional 
graphic elements to the logo 

(i.e., QR code, text)
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CPSC Seal
The CPSC seal is used to validate and legally 
authenticate official documents and reports 
 (for example: an official letter or memo).

Minimum Size
The CPSC seal must be sized large enough  
to be easily read in every application. 

Although minimum sizes are specified, the 
seal should generally appear larger than the 
minimum size.

Clear Space
Clear space is the area surrounding a logo that 
is kept free of other graphics and typography. 
It plays an essential role in ensuring our 
seal is easy to recognize across all of our 
communications. Clear space is essential  
to give our logo prominence. 

To avoid visual clutter, maintain adequate 
clear space between the seal and other visual 
elements. The space surrounding the seal 
should be maximized at all times. 

As illustrated on the right of this page, the 
minimum clear space surrounding the seal is 
specified by:

Section 2.3

Seal Usage

Print Size

Digital Size

100 px

1 in 1 in

Logos

Minimum Size

Clear Space

Colors

C: 0 M: 24 Y: 91 K: 0
PMS: 123 C

CPSC Canary
C: 98 M: 93 Y: 0 K: 0
PMS: 2736 C

CPSC Hydrangea
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Overview
It is important to use the CPSC seal artwork as 
provided to preserve the integrity of the brand. 
The examples on this page illustrate some, but 
not all, potential misuses of the seal. 

Keep in mind that the seal is carefully rendered 
artwork and any alteration of the seal, apart 
from proportional scaling, is considered misuse. 

Section 2.4

Incorrect Use of Seal

Do not add a gradient.

Do not change the seal’s color.

Do not add a drop shadow. Seal should never be pixelated.

Logos

Do not stretch in any way.

Do not place on a busy background.
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CPSC Logo Placement
On all print material, the logo should remain within 
the margins at all times and never cut off.

On all digital material, the logo should be placed 
in the top left of the screen. This includes all 
browser sites, mobile apps, and other digital 
applications.

Section 2.5

Logo Placement

Print Placement

Digital Placement
Website / Microsite Mobile

Logos

 C
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United States 
Consumer Product Safety Commission
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PARTNER
LOGO

Partner and Sub-brand  
Identities
Any partner or sub-brand logos should be sized 
smaller than the CPSC logo. The partner or sub-
brand logo should not be placed in any shapes or 
boxes.

On digital platforms, partner and sub-brand logos 
should be placed in the footer or toward the 
bottom of the page.

Section 2.6

Partner Logo Placement

Digital Placement
Website Mobile

Print Placement

Logos

 C
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Section 3.1

Approach to Brand Fonts

Typography 
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Overview
Typography is another core element of our brand. 
To ensure a consistent look for all communications 
and to differentiate our brand, there is a set of 
typefaces within the Runda and Noto Serif font 
families that must be used. When typography is 
applied consistently, it supports brand recognition 
and equity.

General Rules
Number of Fonts

No more than three font faces per document.

Font Variations

Bold

Italic

Capitalization

Contrast

Text is much easier to read when there 
is a sufficient contrast between the text 
and the background. Black text on a white 
background is the de facto standard for  
both print and the Web.

Font Size

Never use less than 8pt font size.

Section 3.2

Brand Fonts

Runda

Bold AaBbCcDdEe12345789
Medium AaBbCcDdEe12345789
Normal AaBbCcDdEe12345789
Light AaBbCcDdEe12345789
Light Italic AaBbCcDdEe12345789

Used for main headlines, callouts, body copy, and bullet points.

Noto Serif

Regular AaBbCcDdEe12345789
Italic AaBbCcDdEe12345789

Used for subtext and small type.

Typography 
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Section 3.3

Alternative FontsOverview
When Runda is unavailable, Arial should be 
the font used. When Noto Serif is unavailable, 
Georgia should be the font used.

Bold AaBbCcDdEe123457
Regular AaBbCcDdEe123457

Regular AaBbCcDdEe123457
Italic AaBbCcDdEe123457

Arial

Georgia

Typography
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Overview
The sizing of text has been defined on the right. 
This guide is the recommended sizing for best 
legibility and styling. The font size, weight, and 
coloring are all part of the consistent look used  
to establish a strong brand.

Sidebar Headline - Bold, 12pt
Sidebar Body Copy - Light, 8pt leading 11pt. Accusam 
voluptatin rere, ut faces volupide repre niam sequuntiis 
eatem atibus, corro erumquam dolupis simagnim aute nis 
denimoditas sus accus, sae dolorio volum eum, quidebis 
re et remporp orionest aut esti.

Section 3.4

Font Sizing

Headline - Bold, 20pt
Subheads - Medium, 11pt
Body Copy - Light, 10pt leading 13pt. Ita pos eaquae. Accusam voluptatin 
rere, ut faces volupide repre niam sequuntiis eatem atibus, corro 
erumquam dolupis simagnim aute nis denimoditas sus accus, sae 
dolorio volum eum, quidebis re et remporp orionest aut esti disquam 
enient,Ignatem voluptiust et asi aliaspit odit, quam nihilitae optatures 
doloriam et fugiatque ea cullese nistis exces dolorrum facea dunte etur si 
cusci ut ellecae parumquam volut voluptas dellum aspero officil iquasin 
ctiundae nullupt aspitatur sinvendam quuntorerro blaborendit.

Bullet Headline - Medium, 10pt:

	• Bullet - Light, 10pt leading 13pt

	• Bullet - Light, 10pt leading 13pt

	• Bullet - Light, 10pt leading 13pt

	• Bullet - Light, 10pt leading 13pt

Leading = Type Size + 3

Tracking: 0

Body Copy: 90% Black

Headlines: Campaign Color or Frost Blue

Titles: Campaign Color or CPSC Blue

Typography 

Note: the text styles listed to the right apply 
to printed documents. Text styles adjusted for 
presentations are included in the PowerPoint 
template.
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Overview
Typography is another core element of our brand.  
To ensure a consistent look for all communications 
and to differentiate our brand, there is a set of 
typefaces, Runda and Noto Serif, that must be used. 
When typography is applied consistently, it supports 
brand recognition and uniformity.

General Rules
Do Not:

Do not use harsh drop shadows behind text.

Do not use scripts or display fonts  
for large bodies of copy.

Do not distort or stretch fonts.

Do not center align or justify body copy.

Do not compress leading in body copy.

�Do not use color boxes around text  
that hinder readability.

Section 3.5

Incorrect Use of Typography

Typography 

A safer home

Lorem ipsum dolor sit amet.
Written by: Luke William

Sidebar Header

Nemolupt atusanti
autem re aliqui coribea 
illes et, consed quossi 
con rehendunt qui si ut 
volorestem laccaborpos 
ipsantem. Inim is exped 
quam cusaper sperferat 
et ventiat.At pos militate 
dolorer epuditas aut mint.

Sumqui tem non et et 
volende repratur, quam 
unt Igent audaece pelesto 
etur? Borpore stiorum fuga.

Lorem excere volute siment 
volore dio doles maximinturi 
nonectet vendani hicimus 
coria consequiae volorec 
tiorem et haruptae. Nim 
si alicit, quunte labo. Ita et

Sidebar Header

Facerum enditatet quias 
aut velluptae dest, sunt. 
Num resto doluptatquia 
necus volestrum fugiae 
licabo. Rem aut accatis 
ressita quiat acia volores 
cipicium faccus nobitatur

Sidebar Header

Facerum enditatet quias 
aut velluptae dest, sunt. 
Num resto doluptatquia 
necus volestrum fugiae 
licabo. Rem aut accatis 
ressita quiat acia volores 
cipicium faccus nobitatur

Sidebar Header
Enditatet quias aut 
velluptae dest, sunt. Num 
resto doluptatquia necus 
volestrum fugiae licabo. 
Rem aut accatis ressita 
quiat acia volores cipicium 
faccus nobitatur. 

Gendent. Corepudam, que nus dolupta tecabor posanti cor rem est, occus del iur, 
net de verio berum nonseque od molupiditat plam restem. Axim ipsande volori 

sequias invendi blabo. Fugiaero berum quiat que digent explatem fugitist evendame 
corios volo blabo. Ita dellam ipiendam, sit officia doloren ihiciis iumquis endi odit 
ab ipsanduntia quo ex experi quiatur, ut demolese lis vero id quos milit aut rae 

volupta tendesed ut quiam cuptatincto omnimag natemos aut fugite que aut perum 
ipsum facitem nullam fuga. Itaquia seque optaspedissi cum veratur a sunt, sam re, 
con nimporpos explit adic tem unt quaspisi berchilit unt et mi, omnisim re quos 
enist aspis sumquam excerspedi simpos num qui officium, cuptatis et ad quam, si 

voluptu rionse ipsa dolor rercimo luptatur?

Ique et verum nobitiunt ommos modias estem vel ipietus pro officit, simi, alic tore 
estem inventur rerecusam, quidiat volum fuga. Ante nus dolorepudi dusdaestia 

solupita alitiumqui sit quo quo offic testist expelitam veri non net laut aut occatat 
ecaesequunt et doluptium laboreius escimin natibus ea volorep erchili quaturepelis 

aborerf erionet fugiam repeles tiaeper eptatem qui unt repro voluptatur re 
nonsequia cusdam que vollatque odio ipsam aut vit quunt aut ipsum eum facil 

iumquun dusdae parchilla volestibus am, occae nimossit doloreheni corro 
dolorepudi aliquodis eum reste eum nienis reperio. 
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Overview
It is important that type has a strong contrast 
against its background to guarantee the best 
readability, especially for readers with low-vision. 
Sufficient contrast is a requirement for Section 
508 Compliance, see section508.gov for more 
information. On the right are the best color 
background and text color combinations.

CPSC Red is used for warnings or danger  
(i.e. Safety Alerts).

Section 3.6

Type and Color

Typography 

Recalls Pool Safely

Consumers Safety Alert

Recalls Pool Safely

Consumers Safety Alert

CPSC Blue Frost Blue

CPSC RedRaspberry

https://www.section508.gov/


GRID SYSTEMS
Section Four
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Section 4.1

Approach to Grid Systems
The grid is a reliable tool to create layouts to effectively use graphic elements, 
photography, and typography. It guides the shape, size, and positioning of 
each component of the design and provides an opportunity for strategic 
placement when considering information hierarchy and prominence.

Grid Systems
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Busapic tectatis am quiam, nem quaerch ictoriam auda 
qui vent eatusantus moluptatur, que odiorio rporae. Ita 
nost, qui blabo. Id erchill endelia dolorunt et labore dictum 
volupta nobisimus, volessum ea cor audios imet por 
modis ellaborem que sitatemolum faccull auditiis escit 
fuga. Em harchillit res dolumquid mos dolupisi inte plat.

Hent magnis ut aut rehendipsame nos imagnihil mos 
dolupta spicaec atinusaesse nis nam abo. Corrore, ut 
quiandelitat quae dolectoriam eum iliquia voluptasim 
facipsum illisqui sedi viti id quam iure net experfe 
rferionsed mod maximin cienemp orestiost et ident 
imporpo rerchillaut hil id qui qui cus, volorrorumet es 
eati ut dunt ium audis ipsunt as exped et quibus dio. 
Rum sandae delia serfercimus, optatemquo ea duntium 
quassin vendus nest, quam, sinimus in cus, utaeperat ulpa 
voluptas ernatistint mosam a invenis etur?

Consediatur? Modicii ssinvenem nobis dolupta spiendi 
gendanto volum am que ommolorum quam sum 
doluptatio eost et laut pos es ut fugiam ut eostium, 
imillabo. Ceperiae. 

Odipsae natur seque poruptatum sunt dis eariatis 
aperferitas eius sitae sint qui aliquasi quissequam, 
aturiae cullect emoloribus.

Subhead

Ique et verum nobitiunt ommos modias estem vel ipietus 
pro officit, simi, alic tore estem inventur rerecusam, 
quidiat volum fuga. Ante nus dolorepudi dusdaestia 
solupita alitiumqui sit quo quo offic testist expelitam 
veri non net laut aut occatat ecaesequunt et doluptium 
laboreius escimin natibus ea volorep erchili quaturepelis 
aborerf erionet fugiam repeles tiaeper eptatem qui unt 
repro voluptatur re nonsequia cusdam que vollatque odio 
ipsam aut vit quunt aut ipsum eum facil iumquun dusdae 
parchilla volestibus am, occae nimossit doloreheni corro 
dolorepudi aliquodis eum reste eum nienis reperio. Et 
verfero volupti de eum aut ipient facerum rem reperci 
musanihit lab is aceperrovid et fuga. Et as sequo volent.

Sum untisi aut re, sum ut faceat ex et etus mos ent 
es explam atissequos explibus est, con rentur atiis 
conserumque doluptate odisi as magnis sumqui.

Hent labo. Poris autem entio. Ut rem sum di quia vellesene consequid quia nus, omnit eatur, 
con pratur, que lam, que sit renias a velicatium quia quo beri ommod qui. Duce aus esimorae 
consule geremus factum senihil inata, etisto esilius acte que mus, nica interi sensita nos cla 
re, conscrem, C. Satinpre notil const. Turnica elibus nu me publicam.

A safer home

Lorem ipsum  
dolor sit amet.
Written by: Luke William

Sidebar Header

Nemolupt atusanti 
autem re aliqui coribea 
illes et, consed quossi 
con rehendunt qui si ut 
volorestem laccaborpos 
ipsantem. Inim is exped 
quam cusaper sperferat 
et ventiat.At pos militate 
dolorer epuditas aut mint.

Sumqui tem non et et 
volende repratur, quam 
unt Igent audaece pelesto 
etur? Borpore stiorum fuga.

Lorem excere volute 
siment volore dio doles 
maximinturi nonectet 
vendani hicimus coria 
consequiae volorec tiorem 
et haruptae. Nim si alicit, 
quunte labo. Ita et

Sidebar Header

Facerum enditatet quias 
aut velluptae dest, sunt. 
Num resto doluptatquia 
necus volestrum fugiae 
licabo. Rem aut accatis 
ressita quiat acia volores 
cipicium faccus nobitatur

Sidebar Header

Enditatet quias aut 
velluptae dest, sunt. Num 
resto doluptatquia necus 
volestrum fugiae licabo. 
Rem aut accatis ressita 
quiat acia volores cipicium 
faccus nobitatur. 

Family Safety

08USCPSC Mag • May 2025 

Subhead

Gendent. Corepudam, 
que nus dolupta tecabor 
posanti cor rem est, occus 
del iur, net de verio berum 
nonseque od molupiditat 
plam restem. Axim ipsande 
volori sequias invendi 
blabo. Fugiaero berum 
quiat que digent explatem 
fugitist evendame corios 
volo blabo. Ita dellam 
ipiendam, sit officia doloren 
ihiciis iumquis endi odit ab 
ipsanduntia quo ex experi 
quiatur, ut demolese lis 
vero id quos milit aut rae 
volupta tendesed ut quiam 
cuptatincto omnimag 
natemos aut fugite que 
aut perum ipsum facitem 
nullam fuga. Itaquia 
seque optaspedissi cum 
veratur a sunt, sam re, con 
nimporpos explit adic tem 
unt quaspisi berchilit unt et 
mi, omnisim re quos enist 
aspis sumquam excerspedi 
simpos num qui officium, 
cuptatis et ad quam, si 
voluptu rionse ipsa dolor 
rercimo luptatur?

Subhead  
Expelique soluptae vendit 
duntemq uatios dus aligni 
con consero de odit 
litia num sa cus sitis vel 
eriam aut ommodita quis 
mi, sinullabo. Et ommos 
eos nis maion con num, 
optaspercia ni occum nust 
re provit parum ea dolupta 
volupta doluptas eos 
moleseque sitatur, is aut 
aute debit andipsae labo. 
Ut in pe volupta ecestrum 
doluptaspis rem asi toritias 
derrum nat quo blanimus 
dolo volori quidus, que 
di oditionet vid ut quidita 
tempor aut odisciet di dit 
omnihicit rectur rectemp 
editia coreratur soluptur 
apidio omnimag nimporum 
dolla iur?

Bere nonserro magnihic 
tes mincta cum dent expe 
provitiat laborum reicima 
pres voluptatus deleseq 
uosae. Iquam, cuptatin rem 
ut la coreptiae seque

Subhead

Rumquam volupis sit 
hicto blam, quam lis et, 
unt recaeritam faci dis es 
et estisti umquasperum 
laccus.

Nos earum hil minciant 
officipient ipsam que 
vendandanda quo tem 
solupta quibus doluptatur 
sustinis nonsernam fugiatio 
omnis eaquissendam 
as di non corpossin 
eicilis de quissitio. Os 
dolupti aborehent, odi 
con entiuntio eossit pa 
di volorrum quodipsa qui 
illitenit et, voluptaque et 
eium ilibuscil molupic 
tatatest rerspient. Ipita 
ario. Ut ium es molorepe 
ratiuntur aliquatis verferum, 
secus. Nam in corest, 
solorentem dis ab ius.

Toreperum si voluptatque 
enet, odis dolecup taeprem 
re moles veni inullup 
taquam eaqui consecte 
conseque laborion

Overview
Gutter: Blank space between columns of text 
or design elements. Design elements may run 
across the gutter.

Safe Area: The space where text or logos 
should not appear. Design elements that bleed 
off your layout can exist within this safe area.

Margin: A gap around the content of the page 
and the edges. The white space along the 
edges of the document make the page cleaner, 
and the information is easier to read.

Bleed: Design elements that go to the end of 
the page should continue into this area. It will be 
trimmed after the piece is printed.

Section 4.2

Print Material Grids

Letter Size Page - V

Letter Size Page - H

8.5" x 11"

11" x 8.5"

0.1667"

0.1667"

.5"

.5"

.125"

.125"

Safe Area

Gutter

Margin

Bleed

Grid Systems



24 U.S. Consumer Product Safety Commission Brand Guidelines • Visual Identity

0.1667"

.5"

.125"

Magazine Spread

Gate Fold Brochure

8.5" x 11"

14" x 8.5"

0.35"

.5"

.125"

Overview
Gutter: Blank space between columns of text 
or design elements. Design elements may run 
across the gutter.

Safe Area: The space where text or logos 
should not appear. Design elements that bleed 
off your layout can exist within this safe area.

Margin: A gap around the content of the page 
and the edges. The white space along the 
edges of the document make the page cleaner, 
and the information is easier to read.

Bleed: Design elements that go to the end of 
the page should continue into this area. It will be 
trimmed after the piece is printed.

Safe Area

Gutter

Margin

Bleed

Grid Systems
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Trifold
8.5" x 11"

0.25"

.5"

.125"

Overview
Gutter: Blank space between columns of text 
or design elements. Design elements may run 
across the gutter.

Safe Area: The space where text or logos 
should not appear. Design elements that bleed 
off your layout can exist within this safe area.

Margin: A gap around the content of the page 
and the edges. The white space along the 
edges of the document make the page cleaner, 
and the information is easier to read.

Bleed: Design elements that go to the end of 
the page should continue into this area. It will be 
trimmed after the piece is printed.

Safe Area

Gutter

Margin

Bleed

Grid Systems
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Overview
CPSC digital design must be sized correctly for 
multiple screens. These suggested column rides 
will create a clean look and feel. 

Section 4.3

Digital Material Grids

Website

12 col

4 col

8 col

Grid layout

Column (col)

Grid Systems



COLOR PALETTES
Section Five
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Section 5.1

Overview and Approach to Color

Color Palettes
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Section 5.3

Accent Colors

Section 5.2

Brand ColorsBrand Colors
Our primary color palettes are used prominently 
throughout our Visual Identity System. Primary 
application of these colors includes (but is not 
limited to) shapes, backgrounds, and typography.

Accent Colors
Our accent colors underscore the dominant 
blues, adding vitality and brightness to the 
system. The minimal use of these colors will 
support the intention of use as an accent color.

Color Use Rations
The primary blue color palette should represent 
approximately 60% of the application of color. 
The remaining color will be applied as 30% from 
the campaign color palette, and the remaining 
10% will be populated by an accent color.

Color Breakdowns
Pantone: Customized, accurate colors using 
premixed ink during the offset printing process.

CMYK: (cyan, magenta, yellow, black)  
Color mode used for print-ready files in standard 
digital print reproduction.

RGB: (red, green, blue)  
For pieces intended for websites, television, 
social media, or cell phone apps. RGB color  
mode is used to create a perfectly displayed, 
electronic outcome.

HEX: Codes used for online colors are a direct 
translation of the RGB integers.

NOTE: CPSC’s Branding Guidelines do not 
supersede ANSI Standards for Safety Signs  
and Colors.

CPSC Blue

Frost Blue

CPSC Red

Raspberry

White
Pantone 281 C

CMYK: 100, 93, 33, 32

RGB: 29, 39, 88

HEX #: 1d2757

CMYK: 44, 0, 3, 0

RGB: 132, 212, 239

HEX #: 83d3ef

Pantone 186 C

CMYK: 12, 100, 91, 3

RGB: 207, 32, 47

HEX #: cf1f2f

CMYK: 0, 94, 64, 0

RGB: 238, 51, 80

HEX #: ee334f

CMYK: 0, 0, 0, 0

RGB: 255, 255, 255

HEX #: ffffff

Color Palettes
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Section 5.4

How to Use Brand ColorsOverview
Our colors are a powerful piece of our brand. 
Using the palette consistently plays a key role in 
establishing a stable and identifiable brand.

Primary Color
Our primary colors should be used in both large 
areas and as an accent. CPSC Blue should be 
used more than CPSC Red, unless the color is 
being used to show a sign of danger or warning.

Accent Color
The accent colors are used to emphasize type, 
background, and graphic elements.

Primary  

colors

Accent 

colors

Busapic tectatis am quiam, nem quaerch ictoriam auda 
qui vent eatusantus moluptatur, que odiorio rporae. Ita 
nost, qui blabo. Id erchill endelia dolorunt et labore dictum 
volupta nobisimus, volessum ea cor audios imet por 
modis ellaborem que sitatemolum faccull auditiis escit 
fuga. Em harchillit res dolumquid mos dolupisi inte plat.

Hent magnis ut aut rehendipsame nos imagnihil mos 
dolupta spicaec atinusaesse nis nam abo. Corrore, ut 
quiandelitat quae dolectoriam eum iliquia voluptasim 
facipsum illisqui sedi viti id quam iure net experfe 
rferionsed mod maximin cienemp orestiost et ident 
imporpo rerchillaut hil id qui qui cus, volorrorumet es 
eati ut dunt ium audis ipsunt as exped et quibus dio. 
Rum sandae delia serfercimus, optatemquo ea duntium 
quassin vendus nest, quam, sinimus in cus, utaeperat ulpa 
voluptas ernatistint mosam a invenis etur?

Consediatur? Modicii ssinvenem nobis dolupta spiendi 
gendanto volum am que ommolorum quam sum 
doluptatio eost et laut pos es ut fugiam ut eostium, 
imillabo. Ceperiae. 

Odipsae natur seque poruptatum sunt dis eariatis 
aperferitas eius sitae sint qui aliquasi quissequam, 
aturiae cullect emoloribus.

Subhead

Ique et verum nobitiunt ommos modias estem vel ipietus 
pro officit, simi, alic tore estem inventur rerecusam, 
quidiat volum fuga. Ante nus dolorepudi dusdaestia 
solupita alitiumqui sit quo quo offic testist expelitam 
veri non net laut aut occatat ecaesequunt et doluptium 
laboreius escimin natibus ea volorep erchili quaturepelis 
aborerf erionet fugiam repeles tiaeper eptatem qui unt 
repro voluptatur re nonsequia cusdam que vollatque odio 
ipsam aut vit quunt aut ipsum eum facil iumquun dusdae 
parchilla volestibus am, occae nimossit doloreheni corro 
dolorepudi aliquodis eum reste eum nienis reperio. Et 
verfero volupti de eum aut ipient facerum rem reperci 
musanihit lab is aceperrovid et fuga. Et as sequo volent.

Sum untisi aut re, sum ut faceat ex et etus mos ent 
es explam atissequos explibus est, con rentur atiis 
conserumque doluptate odisi as magnis sumqui.

Hent labo. Poris autem entio. Ut rem sum di quia vellesene consequid quia nus, omnit eatur, 
con pratur, que lam, que sit renias a velicatium quia quo beri ommod qui. Duce aus esimorae 
consule geremus factum senihil inata, etisto esilius acte que mus, nica interi sensita nos cla 
re, conscrem, C. Satinpre notil const. Turnica elibus nu me publicam.

A safer home

Lorem ipsum  
dolor sit amet.
Written by: Luke William

Sidebar Header

Nemolupt atusanti 
autem re aliqui coribea 
illes et, consed quossi 
con rehendunt qui si ut 
volorestem laccaborpos 
ipsantem. Inim is exped 
quam cusaper sperferat 
et ventiat.At pos militate 
dolorer epuditas aut mint.

Sumqui tem non et et 
volende repratur, quam 
unt Igent audaece pelesto 
etur? Borpore stiorum fuga.

Lorem excere volute 
siment volore dio doles 
maximinturi nonectet 
vendani hicimus coria 
consequiae volorec tiorem 
et haruptae. Nim si alicit, 
quunte labo. Ita et

Sidebar Header

Facerum enditatet quias 
aut velluptae dest, sunt. 
Num resto doluptatquia 
necus volestrum fugiae 
licabo. Rem aut accatis 
ressita quiat acia volores 
cipicium faccus nobitatur

Sidebar Header

Enditatet quias aut 
velluptae dest, sunt. Num 
resto doluptatquia necus 
volestrum fugiae licabo. 
Rem aut accatis ressita 
quiat acia volores cipicium 
faccus nobitatur. 

Family Safety

08USCPSC Mag • May 2025 

Subhead

Gendent. Corepudam, 
que nus dolupta tecabor 
posanti cor rem est, occus 
del iur, net de verio berum 
nonseque od molupiditat 
plam restem. Axim ipsande 
volori sequias invendi 
blabo. Fugiaero berum 
quiat que digent explatem 
fugitist evendame corios 
volo blabo. Ita dellam 
ipiendam, sit officia doloren 
ihiciis iumquis endi odit ab 
ipsanduntia quo ex experi 
quiatur, ut demolese lis 
vero id quos milit aut rae 
volupta tendesed ut quiam 
cuptatincto omnimag 
natemos aut fugite que 
aut perum ipsum facitem 
nullam fuga. Itaquia 
seque optaspedissi cum 
veratur a sunt, sam re, con 
nimporpos explit adic tem 
unt quaspisi berchilit unt et 
mi, omnisim re quos enist 
aspis sumquam excerspedi 
simpos num qui officium, 
cuptatis et ad quam, si 
voluptu rionse ipsa dolor 
rercimo luptatur?

Subhead  
Expelique soluptae vendit 
duntemq uatios dus aligni 
con consero de odit 
litia num sa cus sitis vel 
eriam aut ommodita quis 
mi, sinullabo. Et ommos 
eos nis maion con num, 
optaspercia ni occum nust 
re provit parum ea dolupta 
volupta doluptas eos 
moleseque sitatur, is aut 
aute debit andipsae labo. 
Ut in pe volupta ecestrum 
doluptaspis rem asi toritias 
derrum nat quo blanimus 
dolo volori quidus, que 
di oditionet vid ut quidita 
tempor aut odisciet di dit 
omnihicit rectur rectemp 
editia coreratur soluptur 
apidio omnimag nimporum 
dolla iur?

Bere nonserro magnihic 
tes mincta cum dent expe 
provitiat laborum reicima 
pres voluptatus deleseq 
uosae. Iquam, cuptatin rem 
ut la coreptiae seque

Subhead

Rumquam volupis sit 
hicto blam, quam lis et, 
unt recaeritam faci dis es 
et estisti umquasperum 
laccus.

Nos earum hil minciant 
officipient ipsam que 
vendandanda quo tem 
solupta quibus doluptatur 
sustinis nonsernam fugiatio 
omnis eaquissendam 
as di non corpossin 
eicilis de quissitio. Os 
dolupti aborehent, odi 
con entiuntio eossit pa 
di volorrum quodipsa qui 
illitenit et, voluptaque et 
eium ilibuscil molupic 
tatatest rerspient. Ipita 
ario. Ut ium es molorepe 
ratiuntur aliquatis verferum, 
secus. Nam in corest, 
solorentem dis ab ius.

Toreperum si voluptatque 
enet, odis dolecup taeprem 
re moles veni inullup 
taquam eaqui consecte 
conseque laborion

Consumer Product Safety Commission

LOREM DOLOR
MAY 2025

Story Title | P. 13

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Story Title | P. 09

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Story Title | P. 03

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Color Palettes
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Section 5.5

Campaign ColorsOverview
The preselected color palettes have been 
created as a unified system of color options 
for campaigns. Each color grouping has been 
named to match any theme a campaign may 
have. For example, “CPSC #03” can be used for 
pool safety campaigns. Each color palette can 
only be used for one campaign at any given time.

Color Breakdowns
CMYK: (cyan, magenta, yellow, black)  
Color mode used for print-ready files in 
standard digital print reproduction.

RGB: (red, green, blue)  
For pieces intended for websites, television, 
social media, or cell phone apps. RGB color 
mode is used to create a perfectly displayed, 
electronic outcome.

HEX: Codes used for online colors are a direct 
translation of the RGB integers.

CMYK: 1, 44, 96, 0

RGB: 246, 158, 38

HEX #: f69e26

CMYK: 75, 3, 36, 0

RGB: 0, 180, 177

HEX #: 00b4b1

CMYK: 68, 16, 4, 0

RGB: 61, 169, 216

HEX #: 3ca9d8

CMYK: 70, 0, 100, 0

RGB: 80, 184, 72

HEX #: 50b848

CMYK: 5, 98, 100, 0

RGB: 227, 39, 38

HEX #: e32726

CMYK: 100, 87, 0, 0

RGB: 0, 59, 169

HEX #: 003ba9

CMYK: 1, 44, 96, 0

RGB: 246, 158, 38 

HEX #: f59d26

CMYK: 32, 17, 91, 0

RGB: 184, 184, 69

HEX #: B8EA45

CMYK: 24, 100, 100, 20

RGB: 161, 27, 19

HEX #: a11b13

CMYK: 27, 0, 100, 0

RGB: 198, 217, 45

HEX #: c6d92d

CMYK: 70, 0, 25, 0

RGB: 32, 190, 198

HEX #: 1fbdc6

CMYK: 87, 33, 100, 26

RGB: 26, 106, 54

HEX #: 1a6a36

CMYK: 100, 91, 32, 34

RGB: 29, 39, 88

HEX #: 1d2757

CMYK: 98, 92, 41, 59

RGB: 13, 18, 55

HEX #: 0d1237

CMYK: 100, 78, 16, 3

RGB: 10, 78, 141

HEX #: 0a4d8c

CMYK: 98, 92, 41, 59

RGB: 13, 18, 55

HEX #: 0d1237

CPSC #01 CPSC #02

CPSC #03 CPSC #04

Color Palettes
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CMYK: 93, 61, 11, 1

RGB: 2, 101, 161

HEX #: 0265a1

CMYK: 92, 81, 0, 0

RGB: 50, 77, 161

HEX #: 324da1

CMYK: 7, 44, 100, 0

RGB: 233, 154, 13

HEX #: e99a0d

CMYK: 62, 51, 35, 8

RGB: 107, 114, 132

HEX #: 6b7284

CMYK: 32, 20, 25, 0

RGB: 168, 183, 183

HEX #: a8b7b7

CMYK: 66, 15, 74, 1

RGB: 97, 165, 108

HEX #: 61a56c

CMYK: 78, 70, 0, 0

RGB: 71, 88, 214

HEX #: 4758d6

CMYK: 17, 4, 100, 0

RGB: 221, 217, 33

HEX #: dcd920

CMYK: 100, 96, 33, 46

RGB: 22, 24, 72

HEX #: 161848

CMYK: 6, 61, 100, 0

RGB: 233, 125, 0

HEX #: e97d00

CMYK: 12, 100, 93, 3

RGB: 207, 32, 47 

HEX #: cf1f2f

CMYK: 22, 15, 100, 0

RGB: 209, 196, 32

HEX #: d1c420

CMYK: 100, 91, 32, 34

RGB: 29, 39, 88

HEX #: 1d2757

CMYK: 32, 0, 16, 0

RGB: 169, 220, 216

HEX #: a9dcd8

CMYK: 70, 67, 65, 76

RGB: 32, 28, 28

HEX #: 201c1c

CMYK: 100, 91, 32, 34

RGB: 29, 39, 88

HEX #: 1d2757

CMYK: 0, 69, 37, 0

RGB: 242, 115, 126

HEX #: f2737e

CMYK: 100, 91, 32, 34

RGB: 29, 39, 88

HEX #: 1d2757

CMYK: 97, 100, 13, 6

RGB: 53, 45, 125

HEX #: 352d7d

CMYK: 76, 44, 85, 42

RGB: 50, 81, 50

HEX #: 325132

CMYK: 60, 3, 100, 0

RGB: 118, 185, 0

HEX #: 76b900

CMYK: 0, 78, 94, 0

RGB: 245, 94, 39

HEX #: f55e27

CMYK: 2, 92, 82, 0

RGB: 234, 58, 58

HEX #: ea3a3a

CMYK: 84, 68, 0, 0

RGB: 62, 95, 172

HEX #: 3e5fac

CMYK: 12, 100, 93, 3

RGB: 207, 32, 47 

HEX #: cf1f2f

CMYK: 12, 100, 93, 3

RGB: 207, 32, 47 

HEX #: cf1f2f

CMYK: 59, 0, 18, 0

RGB: 89, 198, 211

HEX #: 59c6d3

CMYK: 81, 72, 53, 57

RGB: 38, 43, 56

HEX #: 262B38

CMYK: 49, 0, 17, 0

RGB: 119, 209, 216

HEX #: 77d1d8

CMYK: 12, 0, 50, 0

RGB: 230, 243, 153

HEX #: e6f399

CMYK: 9, 58, 100, 1

RGB: 225, 129, 31

HEX #: e1811f

CMYK: 12, 100, 93, 3

RGB: 207, 32, 47 

HEX #: cf1f2f

CPSC #07CPSC #05 CPSC #08CPSC #06

CPSC #11CPSC #09 CPSC #12CPSC #10

Color Palettes
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Section 5.6

How to Use Campaign ColorsOverview
A campaign color palette should be treated 
similarly to brand colors. Using the palette 
consistently across all campaigns creates a 
system that the viewer can understand. It allows 
the campaign to be recognizable as its own 
segment but equally a part of CPSC. 

Primary Color
The primary colors are to be used predominately 
throughout a campaign. The first color in the 
color group should be used as the headline, 
subheads, and call-to-action colors.

Accent Color
The campaign accent colors should be used as 
a small emphasis. These colors should never 
appear more than the campaign primary colors. 

With any crib, bassinet or play yard, 
follow a few simple rules to keep 
babies sleeping safely. Bare is Best!

 Never place pillows or thick quilts 
in a baby’s sleep environment, to 
prevent suffocation,

Make sure there are no gaps 
Gaps larger than two fingers between  
the sides of the crib and the mattress.

Proper assembly of cribs is paramount 
- Follow the instructions provided and
make sure that every part is installed
correctly. If you are not sure, call the
manufacturer for assistance.

Do not use cribs older than 10 years 
or broken or modified cribs. Infants 
can strangle to death if their bodies 
pass through gaps between loose 
components or broken slats while 
their heads remain entrapped.

Set up play yards properly  
According to manufacturers’ 
directions. Only use the mattress pad 
provided with the play yard; do not add 
extra padding.

Never place a crib near a window with 
blinds Curtain cords or baby monitor 
cords; babies can strangle on cords.

For more information please visit 

the Safe to Sleep® public education 

campaign led by The Eunice Kennedy 

Shriver National Institute of Child 

Health and Human Development 

(NICHD) of the National Institutes of 

Health (NIH) and in collaboration with 

other organizations.

Bare is Best

(800) 638-2772

(301) 595-7054

CPSC.gov

Do you know if your baby is #SafeToSleep?
If you just had a baby, are expecting, or are taking care of a young infant 
it’s important to create a safe sleep environment for your baby. Because 
babies spend much of their time sleeping, the nursery should be the 
safest room in the house. Take a few moments to learn about safe sleep.Keep infant cribs free from 

clutter to lowers risk of 
suffocation. Remove pillows 
and thick quilts from your 
baby’s sleeping area.

 C
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Primary  
campaign  
colors

Accent 
colors

Color Palettes
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Photography

Section 6.1

Approach to Imagery
CPSC’s visual representation celebrates the diversity of America.  
The imagery should be relatable and give a feeling of approachability.  
The lifestyle photography is a peek into a moment in time, in a way that is 
natural and unstaged.
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Overview
Photography is an essential element of the 
brand, capturing both context and emotion.  
Our photographic style is representative of our 
brand personality, attributes, and positioning.

Photography principles

Photos should be bright with natural 
lighting. 

The subject is usually posed in a natural 
situation, with either a warm and positive 
or neutral expression.

Images and faces should be clear and crisp.

Photos should feature bright colors.

Photos of products must be on a white 
background or be the main focus in the 
photograph.

Cropping
For the best possible impact, photos should be 
carefully cropped. The cropping should ensure 
that the full subject of the photo is visible.  
Make sure that all important parts of the  
image are within the frame.

Section 6.2

Photography Principles

Photography

Crop Area

Cropping
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Overview
To communicate the brand, it is critical that 
imagery is consistent with CPSC’s established 
tone. The examples on the right show some 
potential misuses.

Photography principles

Photos should not have unnatural  
filters or coloring. 

The photography should never feel dark 
and dreary.

Images should always be crisp and never 
pixelated.

Do not over-glamorize image subjects.

Image backgrounds should never feel 
cluttered or distracting.

Do not use staged or over-posed images.

Product should be easy to spot as the 
subject in an image.

Section 6.3

Incorrect Use of Photography

Photography



GRAPHIC  
ELEMENTS

Section Seven
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Section 7.1

Approach to Graphic Elements

Graphic Elements
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ADULT SENIORTEENTODDLER FAST TRACK
RECALL

Overview
Simple CPSC Blue colored icons are available 
for safety, product risk status, and social media. 
These icons are to be used on presentations, 
digital platforms, and print materials. Icons 
should always be legible and never pixelated.

NOTE: CPSC’s Branding Guidelines do not 
supersede ANSI Standards for Safety Signs  
and Colors.

Icon Placement
When multiple icons are being used, they 
should be separated only by space. The icons 
should never be outlined or rounded by a box 
shape. All social media icons are placed at the 
bottom of any CPSC branded material. 

Color: When used on a color background, icons 
should appear in white. Otherwise, the icons 
should appear primarily in Brand Blue.

Social Media Icons

CPSC Safety Icons

Section 7.2

Brand Icons

Graphic Elements

Product Icons
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CPSC Circles

CPSC Pattern

Section 7.3

Spot GraphicsThe CPSC Pattern
This pattern is made up of half and quarter circles 
overlaid on one another. The inner half circles are 
always CPSC Blue and Frost Blue.  
The outer quarter circles are in Frost Blue and 
CPSC Red or Raspberry colors. The outer quarter in 
Blue Frost should never overlay the inner Blue Frost.

To create the CPSC Pattern, the CPSC Circles are 
rotated and lined up by their outer quarter circles.

Outer Quarter Circle

Inner Half Circle55%

100%

Graphic Elements

The CPSC Pattern is an optional decorative 
element that is used primarily on covers, title 
pages, and posters/banners.
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Overview
Charts and graphs are an important tool to 
visually communicate data and discrete pieces 
of information.

When possible, represent data in an infographic 
style to highlight the information easily to the 
reader. The graphics on this page represent the 
application of our brand colors, type, and circular 
shapes to visualize data.

Graphs and Statistics

D

D

10%

10%

100%

100%

C

C

B

B

A

A

Graphic Elements

D

C

B

A
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Overview
The grayscale graphics are a solution available  
to those without a color printer available.

When possible, represent data in an infographic 
style to highlight the information easily to the 
reader. The graphics on this page represent how 
data can be rendered in black and white.

Graphs and Statistics

D

D

10%

10%

100%

100%

C

C

B

B

A

A

Graphic Elements

D

C

B

A
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Overview
Adding illustrations creates a visual interest to 
a document. Simple vector graphics work best 
with the brand colors. Illustrations can be solid 
shapes or CPSC Blue outlines with a different 
brand color.

Graphic Elements

Illustrations
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Overview
Infographics make data eye-catching and 
shareable. The examples on the right show 
how to effectively use the brand colors and 
type as well as icons and graphs. Use visual 
components when applicable to create interest. 

Infographics can be used to convey a 
wide array of ideas:

•	 Represent significant accomplishments

•	 Display statistics and data

•	 Explain a complex process

Key Elements
Colors: Use brand colors throughout the 
infographic to create interest and hierarchy  
for important information. Use color carefully to 
ensure there is enough white space.

Typography: Scale important type to emphasize 
numbers or facts. 

Icons: Use icons to represent objects as an 
alternative to type when conveying a message.

Cus niet venihiliquam doluptiur minciistrum hillorit quae pera que voluptat 
utatio. Cate volupid explit, qui doluptate plitatquia dolorent eatesciae vent 
adis dunt et occusan ietumquias doluptiost pro incto eiuscip sumquat ioribus

Lut ommo duntemp orposapera dist molupit esti 
aut fuga. Velicta quaepta doloreiunt eum adios 
voluptate natiberes net adi secabo. Lorercipis rem 
faccae postet et officii scitiore verspie ntisquati 
ut officabo. Atur?

Iquam peristius, deatquodin res con re, nonferfex 
se tem escerfe certemus, oritemeris inu senihilia se 
cum quemovena, dieris. Verica; nirtesterviuIferopub 
licio, conius. Factum faci se prora terius conferi 
oraverni suam uteriae

Deatquodin res con re, nonferfex se tem escerfe 
certemus, oritemeris inu senihilia se cum quemovena, 
dieris. Verica; nirtesterviuIferopub licio, conius.  
Factum faci se prora terius conferi oraverni 
suam uteriae. Musa nis imus andit officim pereici 
ustintem andias anihitas de et ium laccusda eos 
estinct enimintota.

Otas ut voloriscid 
etur? Lor alibus. 
Ibusa

Otas ut voloriscid etur? Lor alibus. Ibusa

Otas ut voloriscid etur? 
Lor alibus. Ibusa est res 
dem volo.

Et lam assitaturis 
doloremquam 
etur, elestemperis

Viderovit, ommolum 
quiandi sinti. Accae od 
mod mo con.

Bus acest, 
autemporitat 
pelescipis vollor

Woptat ommo tecto et 
mo te in poremporibus 
et lut ium ditatur.

Ihitas alibus 
rendipsuntem 
nihiliquam ad

Us dolupta tusdam que 
recte eariatem. Gendi 
denihil illatur.

CPSC Red

CPSC Blue

Frost Blue

Raspberry

Section 7.4

Infographics

Annual Report

Infographics Annual Report

Infographics 
Graphs, Colors
Layouts, and
Icons

65%

65% A

85% B

36% E

81% F

70% C

42% D

69% G

53% H

12% I

5%

10%

Subhead 1

Learn more at cpsc.gov Learn more at cpsc.gov

Subhead 2

20%

Callout

Headline for this section goes here.

HeadlineWhat areas are at higher rights?

25%25% 50%

Berry

Frost Blue

CPSC Red

CPSC Red

CPSC Red

CPSC Blue

Lut ommo duntemp 
orposapera dist 
molupit esti 
aut fuga. 

Lut ommo duntemp orposapera dist molupit 
esti aut fuga. Rovidio evendisci delesti orepudi 
pideliqui coresed ignihicimolo occab iur ma as

Am qui del 
iumquisquia ipid 
est, quaeptiz Luptae 
magnisita

Headline for this section goes here.

Graphic Elements
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Applications

Section 8.1

Approach to Applications
The goal of our visual identity is to develop a singular experience regardless 
of the touchpoint while growing recognition to our audience. Our guidelines 
seek to create a personality for CPSC to connect and develop trust with our 
audience. 

The applications in this section demonstrate our brand expression in many 
formats. These examples show how our brand type, colors, graphic elements,  
and photography live in print and digital environments.
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Section 8.2

Print Applications

Poster Template

With any crib, bassinet or play yard, 
follow a few simple rules to keep 
babies sleeping safely. Bare is Best!

 Never place pillows or thick quilts 
in a baby’s sleep environment, to 
prevent suffocation,

Make sure there are no gaps 
Gaps larger than two fingers between  
the sides of the crib and the mattress.

Proper assembly of cribs is paramount 
- Follow the instructions provided and
make sure that every part is installed
correctly. If you are not sure, call the
manufacturer for assistance.

Do not use cribs older than 10 years 
or broken or modified cribs. Infants 
can strangle to death if their bodies 
pass through gaps between loose 
components or broken slats while 
their heads remain entrapped.

Set up play yards properly  
According to manufacturers’ 
directions. Only use the mattress pad 
provided with the play yard; do not add 
extra padding.

Never place a crib near a window with 
blinds Curtain cords or baby monitor 
cords; babies can strangle on cords.

For more information please visit 

the Safe to Sleep® public education 

campaign led by The Eunice Kennedy 

Shriver National Institute of Child 

Health and Human Development 

(NICHD) of the National Institutes of 

Health (NIH) and in collaboration with 

other organizations.

Bare is Best

(800) 638-2772

(301) 595-7054

CPSC.gov

Do you know if your baby is #SafeToSleep?
If you just had a baby, are expecting, or are taking care of a young infant 
it’s important to create a safe sleep environment for your baby. Because 
babies spend much of their time sleeping, the nursery should be the 
safest room in the house. Take a few moments to learn about safe sleep.Keep infant cribs free from 

clutter to lowers risk of 
suffocation. Remove pillows 
and thick quilts from your 
baby’s sleeping area.

 C
O

N
S
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RODUCT SAFETY CO
M

M
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S
IO

N

UNITED STATES

8.5″ x 11″ – V

Application Examples

Overview
Our brand elements are to be used on  
posters to reinforce the connection with CPSC. 
The example on the right is a campaign-specific 
example only for reference. It can be adjusted to 
fit the context.

Photography
When imagery is used on any CPSC material,  
it should never appear pixelated. All images 
should be at 300 dpi resolution. 
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Poster Template

With any crib, bassinet or play yard, follow  
a few simple rules to keep babies sleeping 
safely. Bare is Best!

 Never place pillows or thick quilts  
in a baby’s sleep environment, to prevent 
suffocation,

Make sure there are no gaps 
Gaps larger than two fingers between  
the sides of the crib and the mattress.

Proper assembly of cribs is paramount - 
Follow the instructions provided and make 
sure that every part is installed correctly.  
If you are not sure, call the manufacturer  
for assistance.

Do not use cribs older than 10 years 
or broken or modified cribs. Infants can 
strangle to death if their bodies pass through 
gaps between loose components or broken 
slats while their heads remain entrapped.

Set up play yards properly  
According to manufacturers’ directions.  
Only use the mattress pad provided with 
the play yard; do not add extra padding.

Never place a crib near a window with blinds 
Curtain cords or baby monitor cords; babies 
can strangle on cords.

For more information please visit the Safe to Sleep® public 

education campaign led by The Eunice Kennedy Shriver 

National Institute of Child Health and Human Development 

(NICHD) of the National Institutes of Health (NIH) and in 

collaboration with other organizations.

Bare is Best

(800) 638-2772

(301) 595-7054

CPSC.gov

Do you know if your baby is #SafeToSleep?
If you just had a baby, are expecting, or are taking care of a young infant it’s 
important to create a safe sleep environment for your baby. Because babies 
spend much of their time sleeping, the nursery should be the safest room in 
the house. Take a few moments to learn about safe sleep.

Keep infant cribs free from clutter to lowers 
risk of suffocation. Remove pillows and 
thick quilts from your baby’s sleeping area.

 C
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UNITED STATES

11″ x 8.5″ – H

Application Examples

Overview
Our brand elements are to be used on  
posters to reinforce the connection with CPSC. 
The example on the right is a campaign-specific 
example only for reference. It can be adjusted to 
fit the context.

Photography
When imagery is used on any CPSC material,  
it should never appear pixelated. All images 
should be at 300 dpi resolution. 
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CPSC Safety Alerts Template

CPSC Safety Alerts

02/2018(800) 638-2772 • CPSC.gov • SaferProducts.gov 

 C
O

N
S

U
M

ER
 P

RODUCT SAFETY CO
M

M
IS

S
IO

N

UNITED STATES

Hoverboard Safety
Since fall 2015, CPSC has led the way in warning the public 
about the dangers posed by hoverboards. CPSC is aware 
of more than 250 self-balancing scooter/hoverboard 
incidents related to fires or overheating. In March 2017, 
a 2-year-old girl and a 10-year-old girl died in a house 
fire ignited by a hoverboard in Harrisburg, Pennsylvania. 
From December 1, 2015 through February 2, 2018, CPSC 
received reports from consumers in 44 states of 283 self-
balancing scooter fire or overheating incidents resulting 
in 15 burn injuries, seven smoke inhalation injuries, and 
more than $9 million in property damage, including the 
destruction of six homes and two automobiles.

CPSC recommends that consumers, who own or use 
hoverboards, take these steps to reduce the risk of fire:

 • Use only chargers supplied with the hoverboard.

 •  Only charge a hoverboard when you are there to watch 
it. Do not charge unattended, especially overnight.

 •  Keep away from flammable items while charging  
or even storing your hoverboard.

 •  Check for recalls. Go to: CPSC.gov to see if the 
hoverboard has been recalled. Stop using a recalled 
hoverboard immediately and contact the manufacturer 
for the remedy.

 •  Have working smoke alarms and fire extinguishers  
on every level of your home, outside sleeping areas  
and inside each bedroom.

 •  Report incidents involving hoverboards overheating, 
smoking, or fire to CPSC at Saferproducts.gov.

 •  Hoverboards should be compliant with the UL 2272 
safety standard. However, even UL 2272 compliance 
cannot guarantee that a hoverboard will not overheat 
or catch fire. 

How can you tell if your hoverboard is UL 2272 compliant?

 •  Look for a certification mark for self-balancing 
scooters or personal e-Mobility on the front of the 
packaging and the holographic certification label with 
the Enhanced Mark on the bottom of the product. 
These labels are your indication that you have a 
genuine compliant product. The following example is 
one of a UL certification label:

 •  If you bought your hoverboard before January 29, 2016 
then your hoverboard is not UL 2272 compliant.

 •  Buy from a reputable source. If the price seems 
significantly lower than other hoverboards, the unit  
may not be UL 2272 compliant.

 •  Never purchase a hoverboard from a kiosk, a 
secondhand seller, or an online retailer without proof 
that the hoverboard is compliant with the UL 2272 
safety standard.

 •  Many sellers/retailers claim to have UL-compliant battery 
packs, chargers or other components, but this does not 
mean they are UL 2272 compliant. UL 2272 covers the 
entire hoverboard unit, not just individual parts.

 •  If you are still unsure if the hoverboard is UL 2272 
compliant, ask questions. Ask the seller/retailer to 
provide you with documentation of compliance with  
UL 2272 for the product.

8.5″ x 11"

Application Examples

Overview
CPSC safety alerts campaigns are used to bring 
important notices to the public. Components of 
this campaign should be used consistently. 

Photography
When imagery is used on any CPSC material,  
it should never appear pixelated. All images 
should be at 300 dpi resolution. 

Color
Safety alerts use a specific red intentionally 
selected to draw attention and represent danger. 
This red is used on all safety alert materials. 

CPSC Red: 
C: 5 M: 98 Y: 100 K: 0 
RGB: 227, 39, 38 
HEX #: e32726
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Stationery

Overview
Our logo business card and letterhead are uniform across all 
public outreach categories of CPSC. The stationery pieces are 
extensions of the brand. The letterhead includes the logo to 
the top left along with the contact information underneath. 
Location details for CPSC are placed on the bottom left. It is 
only necessary to use letterhead on the first page of a multiple 
page letter or memorandum.

The front of the business card includes the logo at the top right 
and the back of the business card has the slogan “Here for Your 
Safety,” website, corresponding QR code, and social media icons 
in the center.

Application Examples

U.S. Consumer Product
Safety Commission
4330 East-West Highway
Bethesda, MD 20814

cpsc.gov

National Product Testing
& Evaluation Center
5 Research Place
Rockville, MD 20850

Consumer Product Safety Commission
United States

Office: (301) 504-7454
Mobile: (240) 429-6113
E-mail: ehuegelmeyer@cpsc.gov

4330 East West Highway | Bethesda, MD 20814

Elizabeth Huegelmeyer
Assistant General Counsel

Office of Import Surveillance
U.S. Consumer Product Safety Commission

Keeping Consumers Safe

The CPSC seal is used to validate and legally authenticate 
official documents. Therefore, the seal business card and 
letterhead are appropriate for those with inspection and 
enforcement duties.

The letterhead includes the seal to the top left along with the 
contact information underneath. Location details for CPSC are 
placed on the bottom left. It is only necessary to use letterhead 
on the first page of a multiple page letter or memorandum.

The front of the business card includes the seal at the top right 
and the back of the business card has the slogan “Here for Your 
Safety,” website, corresponding QR code, and social media icons 
in the center.

Personalized letterhead and business cards in either style are 
available only to the CPSC Chair and Commissioners. Suggested 
personalized design shown to the right of the standard 
letterhead for both styles.

U.S. Consumer Product
Safety Commission
4330 East-West Highway
Bethesda, MD 20814

cpsc.gov

National Product Testing
& Evaluation Center
5 Research Place
Rockville, MD 20850

Consumer Product Safety Commission
United States Chairman

Alexander Hoehn-Saric

U.S. Consumer Product
Safety Commission
4330 East-West Highway
Bethesda, MD 20814

cpsc.gov

National Product Testing
& Evaluation Center
5 Research Place
Rockville, MD 20850

Consumer Product Safety Commission
United States

Office: (301) 504-7454
Mobile: (240) 429-6113
E-mail: ehuegelmeyer@cpsc.gov

4330 East West Highway | Bethesda, MD 20814

Elizabeth Huegelmeyer
Assistant General Counsel

Office of Import Surveillance
U.S. Consumer Product Safety Commission

Keeping Consumers Safe

U.S. Consumer Product
Safety Commission
4330 East-West Highway
Bethesda, MD 20814

cpsc.gov

National Product Testing
& Evaluation Center
5 Research Place
Rockville, MD 20850

Consumer Product Safety Commission
United States Chairman

Alexander Hoehn-Saric
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Magazine

Overview
In the sample magazine design on the right,  
we continue to use all of the units of the brand. 
The layout uses the correct four-column grid  
and the established typography, color, and 
pattern. The design includes a sidebar in the 
layout and makes use of illustration for emphasis. 
This layout is for reference and allows room for 
creativity in a way that is on-brand. 

Photography
When imagery is used on any CPSC material,  
it should never appear pixelated. All images 
should be at 300 dpi resolution. 

Application Examples

Consumer Product Safety Commission

LOREM DOLOR
MAY 2025

Story Title | P. 13

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Story Title | P. 09

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Story Title | P. 03

Story summary atusanti 
autem re aliqui coribea  
illes et, consed .

Busapic tectatis am quiam, nem quaerch ictoriam auda 
qui vent eatusantus moluptatur, que odiorio rporae. Ita 
nost, qui blabo. Id erchill endelia dolorunt et labore dictum 
volupta nobisimus, volessum ea cor audios imet por 
modis ellaborem que sitatemolum faccull auditiis escit 
fuga. Em harchillit res dolumquid mos dolupisi inte plat.

Hent magnis ut aut rehendipsame nos imagnihil mos 
dolupta spicaec atinusaesse nis nam abo. Corrore, ut 
quiandelitat quae dolectoriam eum iliquia voluptasim 
facipsum illisqui sedi viti id quam iure net experfe 
rferionsed mod maximin cienemp orestiost et ident 
imporpo rerchillaut hil id qui qui cus, volorrorumet es 
eati ut dunt ium audis ipsunt as exped et quibus dio. 
Rum sandae delia serfercimus, optatemquo ea duntium 
quassin vendus nest, quam, sinimus in cus, utaeperat ulpa 
voluptas ernatistint mosam a invenis etur?

Consediatur? Modicii ssinvenem nobis dolupta spiendi 
gendanto volum am que ommolorum quam sum 
doluptatio eost et laut pos es ut fugiam ut eostium, 
imillabo. Ceperiae. 

Odipsae natur seque poruptatum sunt dis eariatis 
aperferitas eius sitae sint qui aliquasi quissequam, 
aturiae cullect emoloribus.

Subhead

Ique et verum nobitiunt ommos modias estem vel ipietus 
pro officit, simi, alic tore estem inventur rerecusam, 
quidiat volum fuga. Ante nus dolorepudi dusdaestia 
solupita alitiumqui sit quo quo offic testist expelitam 
veri non net laut aut occatat ecaesequunt et doluptium 
laboreius escimin natibus ea volorep erchili quaturepelis 
aborerf erionet fugiam repeles tiaeper eptatem qui unt 
repro voluptatur re nonsequia cusdam que vollatque odio 
ipsam aut vit quunt aut ipsum eum facil iumquun dusdae 
parchilla volestibus am, occae nimossit doloreheni corro 
dolorepudi aliquodis eum reste eum nienis reperio. Et 
verfero volupti de eum aut ipient facerum rem reperci 
musanihit lab is aceperrovid et fuga. Et as sequo volent.

Sum untisi aut re, sum ut faceat ex et etus mos ent 
es explam atissequos explibus est, con rentur atiis 
conserumque doluptate odisi as magnis sumqui.

Hent labo. Poris autem entio. Ut rem sum di quia vellesene consequid quia nus, omnit eatur, 
con pratur, que lam, que sit renias a velicatium quia quo beri ommod qui. Duce aus esimorae 
consule geremus factum senihil inata, etisto esilius acte que mus, nica interi sensita nos cla 
re, conscrem, C. Satinpre notil const. Turnica elibus nu me publicam.

A safer home

Lorem ipsum  
dolor sit amet.
Written by: Luke William

Sidebar Header

Nemolupt atusanti 
autem re aliqui coribea 
illes et, consed quossi 
con rehendunt qui si ut 
volorestem laccaborpos 
ipsantem. Inim is exped 
quam cusaper sperferat 
et ventiat.At pos militate 
dolorer epuditas aut mint.

Sumqui tem non et et 
volende repratur, quam 
unt Igent audaece pelesto 
etur? Borpore stiorum fuga.

Lorem excere volute 
siment volore dio doles 
maximinturi nonectet 
vendani hicimus coria 
consequiae volorec tiorem 
et haruptae. Nim si alicit, 
quunte labo. Ita et

Sidebar Header

Facerum enditatet quias 
aut velluptae dest, sunt. 
Num resto doluptatquia 
necus volestrum fugiae 
licabo. Rem aut accatis 
ressita quiat acia volores 
cipicium faccus nobitatur

Sidebar Header

Enditatet quias aut 
velluptae dest, sunt. Num 
resto doluptatquia necus 
volestrum fugiae licabo. 
Rem aut accatis ressita 
quiat acia volores cipicium 
faccus nobitatur. 

Family Safety

08USCPSC Mag • May 2025 

Subhead

Gendent. Corepudam, 
que nus dolupta tecabor 
posanti cor rem est, occus 
del iur, net de verio berum 
nonseque od molupiditat 
plam restem. Axim ipsande 
volori sequias invendi 
blabo. Fugiaero berum 
quiat que digent explatem 
fugitist evendame corios 
volo blabo. Ita dellam 
ipiendam, sit officia doloren 
ihiciis iumquis endi odit ab 
ipsanduntia quo ex experi 
quiatur, ut demolese lis 
vero id quos milit aut rae 
volupta tendesed ut quiam 
cuptatincto omnimag 
natemos aut fugite que 
aut perum ipsum facitem 
nullam fuga. Itaquia 
seque optaspedissi cum 
veratur a sunt, sam re, con 
nimporpos explit adic tem 
unt quaspisi berchilit unt et 
mi, omnisim re quos enist 
aspis sumquam excerspedi 
simpos num qui officium, 
cuptatis et ad quam, si 
voluptu rionse ipsa dolor 
rercimo luptatur?

Subhead  
Expelique soluptae vendit 
duntemq uatios dus aligni 
con consero de odit 
litia num sa cus sitis vel 
eriam aut ommodita quis 
mi, sinullabo. Et ommos 
eos nis maion con num, 
optaspercia ni occum nust 
re provit parum ea dolupta 
volupta doluptas eos 
moleseque sitatur, is aut 
aute debit andipsae labo. 
Ut in pe volupta ecestrum 
doluptaspis rem asi toritias 
derrum nat quo blanimus 
dolo volori quidus, que 
di oditionet vid ut quidita 
tempor aut odisciet di dit 
omnihicit rectur rectemp 
editia coreratur soluptur 
apidio omnimag nimporum 
dolla iur?

Bere nonserro magnihic 
tes mincta cum dent expe 
provitiat laborum reicima 
pres voluptatus deleseq 
uosae. Iquam, cuptatin rem 
ut la coreptiae seque

Subhead

Rumquam volupis sit 
hicto blam, quam lis et, 
unt recaeritam faci dis es 
et estisti umquasperum 
laccus.

Nos earum hil minciant 
officipient ipsam que 
vendandanda quo tem 
solupta quibus doluptatur 
sustinis nonsernam fugiatio 
omnis eaquissendam 
as di non corpossin 
eicilis de quissitio. Os 
dolupti aborehent, odi 
con entiuntio eossit pa 
di volorrum quodipsa qui 
illitenit et, voluptaque et 
eium ilibuscil molupic 
tatatest rerspient. Ipita 
ario. Ut ium es molorepe 
ratiuntur aliquatis verferum, 
secus. Nam in corest, 
solorentem dis ab ius.

Toreperum si voluptatque 
enet, odis dolecup taeprem 
re moles veni inullup 
taquam eaqui consecte 
conseque laborion
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Application Examples

Overview
Our web banners make use of our key identity 
components: color, typography, imagery, and 
graphic elements. The emphasis on the overall 
brand colors and pattern makes it unmistakably 
CPSC. On the right are examples of various 
layouts that can be used for different sizes and 
orientations of web banners.

Web Banners

180 px x  150 px

160 px x  600 px300 px x  600 px

728 px x  90 px

200 px x  200 px

LEARN MORE LEARN MORE

LEARN MORE

LEARN MORE

LEARN MORE

Headline
Here.

Headline Here.

Headline
Here.

Headline
Here.

Headline
Here.

Find out how you can  
keep your family safe.

Find out how you can keep your family safe.

The CPSC Pattern is an optional design element 
and should only be used in Power Points, 
newsletters, banners, and posters.
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Application Examples

Microsoft PowerPoint Presentation Template

Overview
To make it convenient for you to apply the new CPSC 
branding look to your work products, we’ve developed a 
suite of Microsoft Office templates.

These templates include font styles, colors, banners 
and cover design graphics consistent with the CPSC’s 
branding guidelines.

For CPSC branded templates visit:

https://cpscgovdc.sharepoint.com/sites/CMSPO/SitePages/CPSC-Branded-Templates.aspx

Or use the link on the CPSCnet homepage- look for 
“Templates” under the “Quick Links” list on the right sidebar.

Presentation Template
The presentation template includes a two different 
options for a CPSC branded title slide, a body slide, and a 
closing slide, plus text style guidelines. Additional branded 
slide layout options are provided in PowerPoint under 
“new slide.” Replace the text with your own, or delete what 
you don’t need.

Title Slide Option 1

Title Slide Option 2

Body Slide

Closing Slide

https://cpscgovdc.sharepoint.com/sites/CMSPO/SitePages/CPSC-Branded-Templates.aspx
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Application Examples

Report Document Template
Use the Report Document Template for 
documents over 10 pages long that require a 
table of contents. 

The template includes a branded cover page, text 
styles, image guidelines, table styles, call-out box 
styles, footer styles, and formatting tips. Replace 
the text with your own, or delete what you  
don’t need.

Short Document Template
Use the Short Document Template for 
documents that are under 10 pages long and do 
not require a cover page or table of contents. The 
template includes a branded header graphic, text 
styles, table styles, and formatting tips. Replace 
the text with your own, or delete what you  
don’t need.

Microsoft Word Report Document Template

  

Add Report Title Here [Style: Title] 
Add Month and Year of Publication Here [Style: 
Subtitle] 

Microsoft Word Short Document Template

 

 

Add Report Title Here | Add Month and Year of Publication Here | cpsc.gov 

2 

Table of Contents 
Styles and Formatting [Style: Heading 1] ............................................................................... 3 

Sample Bullet Styles [Style: Heading 2] .................................................................................. 3 

Setting-up the Table of Contents [Style: Heading 1] ............................................................. 4 
Generating and Updating the Table of Contents [Style: Heading 2] ........................................ 4 

Styles Incorporated in the Table of Contents [Style: Heading 3] .......................................... 4 

Alternative Text Descriptions for Images [Style: Heading 1] ................................................ 4 

Table [Style: Heading 1] .......................................................................................................... 6 

Call Outs [Style: Heading 1] .................................................................................................... 6 

Saving Your Document [Style: Heading 1] ............................................................................. 6 
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Styles and Formatting [Style: Heading 1] 
This template is for long documents that are generally more than 30 pages long in total and 
require a table of contents. If a template for a shorter document would be a better fit for your 
project, please see the Short Document Template in the same location that you found this file. 
All of the text that is currently in this file is intended to be replaced or deleted, and provides 
Microsoft Word formatting tips. 

This template was created with styles. Examples of the various styles make up the example 
copy for this template. Please delete any section or text in the template that is not needed. 
Styles are formatting shortcuts that incorporate information about spacing, tabs, and fonts, and 
are critical to preserving the design. It best if you use the Style function to update the copy in 
this document. Predetermined styles for this document will be noted in brackets [Style: XXXX]. 

The available styles appear under the “Home” tab, 4th section from the left (Clipboard, Font, 
Paragraph, then Styles) click on the down arrow in the Styles section to open a drop-down 
menu which will display all the available styles. To choose a style for a header or paragraph, 
highlight your text and click the style you want; the change will be applied automatically.  

This document is a template; therefore, you will need to save it as a new file as soon as you 
start incorporating text. To save go to File > Save As > Format > Word Document and name 
your file. [Style: Normal] 

Sample Bullet Styles [Style: Heading 2] 

Here are several examples of bullet styles for this document:  
• Sample text with [Style: Bullet 1] style selected. 
• Another sample of Bullet 1 

• Sample test with [Style: Bullet 2] style selected 

• Another example of Bullet 2 

1. Numbered lists should automatically continue numbering when compiling a list and should 
also restart numbering when you start a new list. To make edits to the numbers, simply right-
click on the number you want to change and select Restart Numbering or Continue 
Numbering and the list will adjust accordingly. [Style: Numbered List] 

 

 

Add Report Title Here | Add Month and Year of Publication Here | cpsc.gov 

4 

Setting-up the Table of Contents [Style: Heading 
1] 
Generating and Updating the Table of Contents [Style: Heading 2] 

A Table of Contents is suggested for any long format document. Word can generate a Table of 
Contents automatically based on your use of styles in the document. To update the Table of 
Contents as you update your document, click anywhere within the Table of Contents > right-
click > Update Field.  

Styles Incorporated in the Table of Contents [Style: Heading 3] 
The Table of Contents at the beginning of this document uses three styles to differentiate the 
various levels of content (i.e., TOC 1, TOC 2, TOC 3). The text you use in your headings will 
become the text for your Table of Contents. If when you review your Table of Contents you 
notice it included text that you did not want, you must go to that page that has that content and 
apply a different style to that text. Or highlight the text, go to the References tab in the toolbar, 
hold down the “Add Text” button, and choose the “Do not show in Table of Contents” option. 
This will change the style and omit the text. You can also click on the text in the Table of 
Content and manually adjust the wording there. Please note if you make manual edits and later 
update the table, your edits will be replaced. 

Alternative Text Descriptions for Images [Style: 
Heading 1] 
In 1998, Congress amended the Rehabilitation Act of 1973 to require Federal agencies to make 
their electronic and information technology (EIT) accessible to people with disabilities. Under 
Section 508, agencies must give disabled employees and members of the public access to 
information comparable to the access available to others. To meet the legal requirement for 508 
compliance, all files must be readable by screen-reading software. This means that all images 
must have alternative text descriptions (also called “alt text”) to be 508 compliant. Alt text allows 
people with disabilities equal access to the information conveyed by the image. Images include 
(but are not limited to): 

• Art 

• Photographs 

• Diagrams 

• Graphs 
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• Logos 

• Screenshots 

Alt text is not necessary for images that don’t convey information, such as images that are 
purely decorative (example: solid color shapes in the background of a design). 

To add alt text to an image or other non-text element: 

1. Right-click on the image. 

2. Select “Edit Alt Text” from the menu. 
3. A pane will appear on the right. In the field provided, type a brief but complete description of 

the image and the key information it is conveying.  
4. Click on “Close.” 
 

Figure 1: Alt Text Pane [Style: Figure Title] 
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Figure 2: Example of a Chart with a Figure Title [Style: Figure Title] 

 

Table [Style: Heading 1] 
CPSC Light Blue Table Style Example [Style: Table Title] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

Call Outs [Style: Heading 1] 
Call Out Box Heading [Style: Call Out Box Heading] 
This style will put a blue box behind your call out to make it stand out. [Style: Call Out] 

Saving Your Document [Style: Heading 1] 
Please note you cannot save over this template. The reason for this is to ensure that no matter 
what changes you make to the file, the template will remain unchanged. To save this document 
with your content, go to File > Save As and then name your file and select Word Document from 
the second drop down. 

 

 
 

Month Day, Year [Style: CPSC Date] 

Page 1 of 3 

 

Styles and Formatting [Style: Heading 1] 
This template is for brief documents which are generally less than 10 pages long in total and do 
not require a table of contents. If a template for a longer document would be a better fit for your 
project, please see the Report Template in the same location that you found this file. All of the 
text that is currently in this file is intended to be replaced or deleted and contains MS Word 
formatting tips. 

This template was created with styles. Examples of the various styles make up the example 
copy for this template. Please delete any section or text in the template that is not needed. 
Styles are formatting shortcuts that incorporate information about spacing, tabs, and fonts, and 
are critical to preserving the design. It best if you use the Style function to update the copy in 
this document. Predetermined styles for this document will be noted in brackets [Style: XXXX]. 

The available styles appear under the “Home” tab, 4th section from the left (Clipboard, Font, 
Paragraph, then Styles) click on the down arrow in the Styles section to open a drop-down 
menu which will display all the available styles. To choose a style for a header or paragraph, 
highlight your text and click the style you want; the change will be applied automatically.  

This document is a template; therefore, you will need to save it as a new file as soon as you 
start incorporating text. To save go to File > Save As > Format > Word Document and name 
your file. [Style: Normal] 

Sample Bullet Styles [Style: Heading 2] 

Here are several examples of bullet styles for this document:  

• Sample text with [Style: Bullet 1] style selected. 

• Sample test with [Style: Bullet 2] style selected. 

1. Numbered lists should automatically continue numbering when compiling a list and should 
also restart numbering when you start a new list. To make edits to the numbers, simply right-
click on the number you want to change and select Restart Numbering or Continue 
Numbering and the list will adjust accordingly. [Style: Numbered List] 

Alternative Text Descriptions for Images [Style: 
Heading 1] 
In 1998, Congress amended the Rehabilitation Act of 1973 to require Federal agencies to make 
their electronic and information technology (EIT) accessible to people with disabilities. Under 

 
 

Month Day, Year [Style: CPSC Date] 

Page 2 of 3 

 

Section 508, agencies must give disabled employees and members of the public access to 
information comparable to the access available to others. To meet the legal requirement for 508 
compliance, all files must be readable by screen-reading software. This means that all images 
must have alternative text descriptions (also called “alt text”) to be 508 compliant. Alt text allows 
people with disabilities equal access to the information conveyed by the image. Images include 
(but are not limited to): 

• Art 

• Photographs 

• Diagrams 

• Graphs 

• Logos 

• Screenshots 

Alt text is not necessary for images that don’t convey information, such as images that are 
purely decorative (example: solid color shapes in the background of a design). 

To add alt text to an image or other non-text element: 

1. Right-click on the image. 

2. Select “Edit Alt Text” from the menu. 
3. A pane will appear on the right. In the field provided, type a brief but complete description of 

the image and the key information it is conveying.  
4. Click on “Close.” 

 

Figure 1: Example of a Chart with a Figure Title [Style: Figure Title] 
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Table [Style: Heading 1] 
CPSC Light Blue Table Style Example [Style: Table Title] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Header] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

[Style: Table 
Body] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

• [Style: Table 
Bullet] 

Call Outs [Style: Heading 1] 
Call Out Box Heading [Style: Call Out Box Heading] 
This style will put a blue box behind your call out to make it stand out. [Style: Call Out] 

Saving Your Document [Style: Heading 1] 
Please note you cannot save over this template. The reason for this is to ensure that no matter 
what changes you make to the file, the template will remain unchanged. To save this document 
with your content, go to File > Save As and then name your file and select Word Document from 
the second drop down. 
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Letterhead & Memo Templates
The letterhead and memo templates include a uniform 
branded header and footer graphic and text styles 
with general CPSC contact information (website, email 
address, and phone number).

Replace the placeholder text with your own, and 
delete what you don’t need. Add your personal contact 
information in the body of the letter.

It is only necessary to use letterhead on the first page of 
a multiple page letter or memorandum.

Letterhead and memo templates are also available with 
the official CPSC seal. The CPSC seal is used to validate 
and legally authenticate official documents. Therefore, 
the business card and letterhead with the seal are 
appropriate for those with inspection and  
enforcement duties.

Application Examples

Microsoft Word Letterhead & Memo Templates

 

 

 
March 2, 2022 
 
[Recipient Name Here] 
[Recipient Mailing Address Here] 

 
Dear [Name Here]: 
 
[Letter body here.] 
 
Sincerely, 
 
[Name] 
[Title] 
[Office Name] 
 
 
Enclosure(s):  
 

 
Memorandum 

      Page 1 of 3 

This memorandum was prepared by the CPSC staff. It has not been reviewed  
or approved by, and may not necessarily reflect the views of, the Commission. 

 

TO: [Name] DATE: [Month Day, Year]   

THROUGH: [Name]  

FROM: [Name]  

SUBJECT: [Subject]  
 

 

 

  

 

  

March 2, 2022 
 
[Recipient Name Here] 
[Recipient Mailing Address Here] 
 
Dear [Name Here]: 
 
[Letter body here.] 
 
Sincerely, 
 
[Name] 
[Title] 
[Office Name] 
 

 
 

Enclosure(s): 
 

 
Memorandum 

      Page 1 of 3 

This memorandum was prepared by the CPSC staff. It has not been reviewed  
or approved by, and may not necessarily reflect the views of, the Commission. 

 

TO: [Name] DATE: [Month Day, Year]   

THROUGH: [Name]  

FROM: [Name]  

SUBJECT: [Subject]  
 

 

 

  

Personalized letterhead and memo templates are 
available upon request in either style only to the CPSC 
Chair and Commissioners (See example of personalized 
stationery on page 51).
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Overview
An email signature is our digital business card. A consistently branded 
email signature displayed throughout CPSC shows that we are a 
professional, cohesive organization with every email we send.

Email Signature

Email Text Body Font: Arial, 11 pt., black

Name Font: Arial Bold, 12 pt., CPSC Blue
Title Font: Georgia, 11 pt., CPSC Red
Email Signature Body Font: Arial, 10 pt., CPSC Blue

______________________ 
  
  
Bob Smith 
Specialist 
U.S. Consumer Product Safety Commission | International Office 
4330 East West Highway | Bethesda, MD 20814 
Office: (301) 555-2100 | Mobile: (240) 555-2200 | Fax: (240) 555-2300 
 
Follow Us: Facebook, Twitter, Instagram, YouTube 
 
 

Email Signature Template
The email signature template includes text styles and colors that 
comply with CPSC’s Branding Guidelines. Replace the template text 
with your contact information, delete what you don’t need, then copy 
and paste it into Microsoft Outlook email signature options (click here 
for more information on how to set MS Outlook signature options).

The CPSC Chair and Commissioners are encouraged to follow our 
branding guidelines, suggested design shown to the right.

NOTE: The default disclaimer text that is added to external emails by 
EXIT will continue, and therefore CPSC’s Branding Guidelines do not 
apply to it.

Template Text Styles
Settings used in the Email Signature Template text styles are listed to 
the right.

See Section 5.1 of this document for CPSC Red and CPSC Blue color 
formulas in RGB.

Application Examples

Dear Mr. Jones,

My contact information is in my signature below.

Regards,

https://support.microsoft.com/en-gb/office/change-an-email-signature-86597769-e4df-4320-b219-39d6e1a9e87b


PRODUCTION
Section Nine



59U.S. Consumer Product Safety Commission Brand Guidelines • Visual Identity

U.S. Consumer Product
Safety Commission
4330 East-West Highway
Bethesda, MD 20814

National Product Testing
 & Evaluation Center
5 Research Place
Rockville, MD 20850

800.638.2772
info@cpsc.gov
cpsc.gov

Production

Overview
Our brand has been carefully developed in order 
to assure our quality of work is strong from start 
to finish. When it comes to producing the final 
product, we must ensure it meets the highest 
standard. This section is a guide to meeting those 
requirements. Use the information provided when 
preparing a file for print to guarantee best results. 

CMYK: (cyan, magenta, yellow, black)  
Use this color mode when designing 
materials for print.

Colors: Use PMS (Pantone) for primary brand 
colors when applicable. 

Pantone: This customized method of printing is 
the best way to reproduce a color using premixed 
ink during the offset printing process.

Bleed: Add .125" bleed to any print document that 
includes graphics or colors that run off the page. 

Section 9.1

Print and Digital Production

300 dpi
Photos should be scaled 
between 50% and 115%

Bleed 

PMS Color

CMYK File

Print Material



60 U.S. Consumer Product Safety Commission Brand Guidelines • Visual Identity

Production

Headline
Here.

100 dpi
For large format 
prints and should  
be scaled at 100%

CMYK File

Trade Show / Large Format

Overview
Our brand has been carefully developed in order 
to assure our quality of work is strong from start 
to finish. When it comes to producing large-scale 
designs, we must ensure it meets the highest 
standard. This section is a guide to meeting those 
requirements. Use the information provided when 
preparing a file for print to guarantee best results.

CMYK: (cyan, magenta, yellow, black)  
Use this color mode when designing 
materials for print.

Colors: Use PMS (Pantone) for primary brand 
colors when applicable. 

Pantone: This customized method of printing is 
the best way to reproduce a color using premixed 
ink during the offset printing process.

Bleed: Add .125" bleed to any print document that 
includes graphics or colors that run off the page. 
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Production

LEARN MORE

Headline
Here.

72 dpi

RGB File

Web Banner Image

Overview
When it comes to producing digital work,  
we must ensure it meets the highest standard. 
This section is a guide to meeting those 
requirements. Use the information provided 
when preparing a file to guarantee best results.

RGB: (red, green, blue)  
Use this color mode when designing for websites, 
television, social media, or cell phone apps.

Photography: Set photography to at least  
72 dpi, and never use a pixelated image.

Video
When designing video it is important to include 
the CPSC logo in the bottom right corner of the 
frame. Select the version of the logo which 
has the best contrast against the video 
background so that the text in the ring is 
legible. Use consistent sizing and placement 
as follows:

Logo Placement:

Logo Size: 216x218

Logo Position:

Standard (I920x1080 Screen Size):  
x:1616 y: 807

Vertical for Social (1080x1920 Screen Size): 
x:754 y: 1604

Video
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Production

Overview
Paper can play an important role in how people 
interact with a product. To show our attention to 
detail, use these suggested paper stock weights 
and coatings for the listed applications. 

Section 9.2

Paper Stock & Coatings

Printed White Paper Reports: 80lb Uncoated 
Text Weight for Cover and Interior.

Single Pagers & Posters: 100lb Gloss Coated.

Brochures & Trifolds: 100lb Gloss Coated Cover 
& 100lb Text Weight Gloss Interior Pages.

Fans & Door Hangers: 100lb Cover Gloss Coated 
and 5 Mil Laminate Encapsulation.



63U.S. Consumer Product Safety Commission Brand Guidelines • Visual Identity

Production

Overview
There are a few things to consider when deciding 
how put a document together. The binding method 
can add to the overall aesthetic of the piece. On 
this page, we suggest which methods work best for 
different types of documents.

Saddle stitching is when folded pages are stapled 
at the center. It is usually best to saddle stitch when 
a brochure, catalog, or booklet is under 48 pages.

Perfect binding is used for catalogs, directories,  
and paperback books with higher page counts.  
The cover is wrapped around the pages, then 
trimmed to its finished size.

Score and fold is best for single-page  
brochures, cards, and pamphlets.

Section 9.3

Binding

Saddle Stitched or Perfect Bind:  
No Comb, Coil, or Wire-O Binding.

Score & Folds: Ridges that are indented  
into the paper where the fold line will occur.



508 COMPLIANCE
Section Ten
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508 Compliance

Section 10.1

508 Compliance
Section 508 requires that all website content be accessible to people with 
disabilities. This applies to web applications, web pages and all attached files 
on the Intranet, as well as, the Internet. CPSC staff are required to comply with 
the provisions of Section 508 and ensure accessibility of online electronic 
content, including but not limited to websites, web applications, multimedia, 
and office documents, including Word, PowerPoint, Excel, and PDF. GSA has 
put together guides and tutorials to provide methods to help you make your 
content accessible and Section 508 compliant. These resources can be 
accessed at the following url:

https://www.section508.gov/

https://www.section508.gov/


RESOURCES  
& CONTACTS

Section Eleven



Resources and Contacts

Assets and Templates
For CPSC branded templates visit:

https://cpscgovdc.sharepoint.com/sites/CMSPO/SitePages/CPSC-Branded-Templates.aspx

Or use the link on the CPSCnet homepage- look for “Templates” under the “Quick Links” list on the right sidebar.

Contacts
For questions about CPSC’s branding: 
Ann Bowen 
Visual Information Specialist 
Office of Communications 
abowen@cpsc.gov

For general questions: 
(800) 638-2772 
info@cpsc.gov 
cpsc.gov 

U.S. Consumer Product Safety Commission 
4330 East-West Highway  
Bethesda, MD 20814

National Product Testing 
& Evaluation Center 
5 Research Place 
Rockville, MD 20850

https://cpscgovdc.sharepoint.com/sites/CMSPO/SitePages/CPSC-Branded-Templates.aspx
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